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Introduction 
 

This curriculum module takes participants through two comprehensive projects: 
1) conducting and recording oral history interviews, including the creation of indices of 
content drawing upon the preferred methods of the field; and 2) weaving together 
multiple oral histories and participants’ oral narration to tell stories about their city in 
podcasts. As explained in the Overview, participants chose several themes tied to the 
project’s place-based learning approach that focused the content of their resultant oral 
history interviews and podcasts. 

This module provides participants an opportunity to practice Common Core 
Standards skills in interpreting diverse media and developing an artifact of their own. In 
this way, students are practicing methods described by the International Society for 
Technology in Educations Standards for Students (2020). They are learning how to be 
“digital citizens” and “knowledge constructors” through socially-responsible contributions 
to their community. The module is designed to support participants as they build skills of 
self-efficacy and collaboration. Participants practice self-direction to complete tasks and 
function independently even as they reach the common goal of producing a podcast 
together.  
 
Oral History 
 

Oral history interviewing collects the memories, thoughts, and ideas of people 
about a historical event or place. The Oral History Association (2020) is an excellent 
resource for learning more about the field and its practices. K-12 students usually learn 
about history through the significant dates and descriptions in textbooks. By conducting 
their own oral history interviews, however, participants learn to value the unique 
experiences of people in their community. They also begin to conceptualize how culture 
plays a role in shaping and defining places, including the town they call home.  

Oral history interviewing is a hands-on method for teaching participants about 
active listening, non-verbal cues, and interpersonal communication. In order to be 
informed interviewers and ask applicable questions, participants must conduct their own 
research into local history. They then learn how to write open-ended questions that 
focus the interviewee on a particular topic. They must consider how their own persona 
influences what the interviewee is willing to share. In addition, through practice, they 
learn how to ask relevant follow-up questions and guide the interview into a more 
thorough consideration of the subject. The participants gain skills in professional audio 
recording, including setting up the ideal sound environment and using recording 
equipment to capture a high-quality sound file. After conducting interviews, participants 
use audio engineering software to create indices for each oral history recordings to 
make them accessible for others. 
 
Podcasting 
 

Podcasts are spoken stories or episodes saved as digital audio files made 
available for streaming and download on the internet. They are often shared as part of a 
larger series. Using podcasts as a medium in which participants analyze oral histories 

https://www.iste.org/standards/for-students
https://www.iste.org/standards/for-students
https://www.oralhistory.org/


 
 

5 
 

and develop their own narratives empowers them to view themselves as technologists, 
historians, and authors.  

By producing their own podcasts, participants learn what makes a good story and 
how to draw upon the indices created while analyzing their oral histories in order to 
interweave segments in the service of a logical narrative. Podcasting gives participants 
practice in the process of writing for multimodal formats. They create story maps using 
movable post-it notes to experiment with the most impactful structure for their stories. 
Drawing upon tutorials, participants experiment with audio editing software, adding 
music and sound effects to further enhance the emotional impact of their productions. 
 
Equipment and Software 
 

Any handheld digital recording device will work effectively for creating podcasts. 
We used handheld mp3 recorders, but most smartphones can easily record high quality 
audio. For iPhones, we recommend the Voice Memos app that is included by default, 
and for Android devices, we recommend the Smart Recorder app. In addition to 
handheld devices, we also used high-end plug-in microphones to set up realistic 
recording stations for participants. Instructors might consider a day wherein participants 
collaborate to construct a recording studio with egg carts for sound buffers and other 
easy-to-adapt fixes to construct the ideal environment. 

There are several options for editing audio files. Audacity is a free, open-source 
platform for audio editing that can be easily downloaded to most computers, except for 
Chromebooks. Audacity is widely used for audio editing and has many online tutorials 
and resources. Soundtrap is an online editing environment that offers a free one-month 
trial for educators and will work on any computer including Chromebooks. The module 
includes tutorials for both platforms.  

https://apps.apple.com/us/app/voice-memos/id1069512134
https://play.google.com/store/apps/details?id=com.andrwq.recorder
https://www.amazon.com/Shure-MV51-Large-Diaphragm-Condenser-Microphone/dp/B010W6WFEA/
https://www.audacityteam.org/
https://www.soundtrap.com/edu/
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Curriculum Goals 
 

Essential Questions 

• What is oral history? 
• What can be gained from oral history as compared to other methods of learning 

about the past? 
• How do the everyday experiences of people shape the identity of a place and its 

inhabitants? 
• What is a “podcast”? 
• How can podcasts be used to share history and culture? 
• How are podcasts different from other forms of media? 
• What are the elements that comprise a good story? 
• Why is it essential to conduct research using multiple source formats? 
• How do you craft pertinent research questions? 

 
Key Knowledge and Skills to be Gained 

Participants will:  
• Know the definition and purpose of oral history. 
• Write open-ended interview questions. 
• Consider aspects of interpersonal communication and non-verbal cues in their 

interview practice. 
• Learn to set up the environment and equipment to record an interview with good 

sound quality. 
• Use audio editing software to index an audio recording. 
• Conduct research using multiple source formats. 
• Plan the elements of a story to construct a logical, compelling narrative using 

story mapping and scripting processes. 
• Use audio editing software to clip, split, join and otherwise edit a podcast for 

dramatic effect using voice, music, and ambient noise. 
 
Standards Addressed 
 
International Society for Technology in Education Standards for Educators 

• 3a - Create experiences for learners to make positive, socially responsible 
contributions and exhibit empathetic behavior online that build relationships and 
community. 

• 5a - Use technology to create, adapt and personalize learning experiences that 
foster independent learning and accommodate learner differences and needs. 

  
International Society for Technology in Education Standards for Students 

• 1b - Students build networks and customize their learning environments in ways 
that support the learning process. 

• 3a - Students plan and employ effective research strategies to locate information 
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and other resources for their intellectual or creative pursuits. 
• 3b - Students evaluate the accuracy, perspective, credibility and relevance of 

information, media, data or other resources. 
• 4a - Students know and use a deliberate design process for generating ideas, 

testing theories, creating innovative artifacts or solving authentic problems. 
• 4b - Students select and use digital tools to plan and manage a design process 

that considers design constraints and calculated risks. 
• 6b - Students create original works or responsibly repurpose or remix digital 

resources into new creations. 
• 6c - Students communicate complex ideas clearly and effectively by creating or 

using a variety of digital objects such as visualizations, models or simulations. 
 
Common Core English-Language Arts 

• CCSS.ELA-LITERACY.SL.8.2 - Analyze the purpose of information presented in 
diverse media and formats (e.g., visually, quantitatively, orally) and evaluate the 
motives (e.g., social, commercial, political) behind its presentation. 

• CCSS.ELA-LITERACY.SL.8.1.C - Pose questions that connect the ideas of 
several speakers and respond to others' questions and comments with relevant 
evidence, observations, and ideas. 
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Summary of Lessons and Activities 
 

Section 1 – Oral History Interviews (8 days) 
Curriculum 

Section Objectives Activities 
Completed  

1.1 Introduction to 
Oral Histories  

• Describe an oral history 
• Compare and contrast aspects of 

high-quality oral histories 

• 1.1.1 Listening for 
the Story 

1.2 Open-Ended 
Questions 

• Contrast open-ended questions 
• Create good interview questions 

• List of questions 

1.3 Audio Recording 
Scavenger Hunt 

• Evaluate a recording for quality 
• Consider factors to create a good 

recording environment 

• 1.3.1 Audio 
Recording 
Scavenger Hunt 
and recordings 

1.4 Recording and 
Audio Editing 
Tutorials 

• Record an interview with another 
student 

• Create a basic recording with editing 

• Audio files created 
through tutorial 

1.5 Developing 
Interview Skills 

• Use professional interview skills 
• Evaluate others’ interview skills  

• Interview activity 

1.6 Conducting 
Interviews 

• Conduct an oral history interview • Interview 
recordings 

1.7 Indexing Oral 
History Interviews 

• Select important parts of interviews 
• Summarize interview answers 

• Oral history 
interview indices 

Section 2 – Creating a Podcast (14 Days) 

1.8 Introducing 
Podcasts and 
Choosing Central 
Questions 

• Define podcast 
• Identify a Theme Question 

• Initial podcast plans 

1.9 Research • Conduct relevant research based on 
central question 

• Learn about differences in source 
format content 

• 1.9.1-5 Finding 
Information 

1.10 Podcast Story 
Mapping 

• Identify an audience 
• Create a story map 
• Develop collaborative planning skills 

• Story Maps 
• 1.10.1 Podcast 

Tasks 
1.11 Creating 
Podcasts 

• Choose and export audio clips 
• Make scripts and recordings 
• Add music and audio effects 

• Completed 
Podcasts 
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1.1 Introduction to Oral Histories 
 
Recommended Time: 50 Minutes 
 
OVERVIEW  
In this lesson, participants listen to oral histories and learn why oral history should be 
valued. Participants begin by creating a brief history of their own, then listen to oral 
histories and evaluate them, determining what their key components are. 
Participants will be able to… Opportunities for Assessment 
Define oral history Student responses 
Consider aspects of oral histories Class discussions and Listening for the 

Story sheets Compare aspects of oral histories 
 
STANDARDS ADDRESSED 
• CCSS.ELA-LITERACY.SL.8.2 - Analyze the purpose of information presented in 

diverse media and formats (e.g., visually, quantitatively, orally) and evaluate the 
motives (e.g., social, commercial, political) behind its presentation. 

 
PREPARATION 
Materials 

• Computers 
• Headphones 
• Headphone 

splitters 
• 1.1.1 Listening 

for the Story 

Resources 
• StoryCorp Griot (2020): 

https://storycorps.org/discover/griot/ 
• Library of Congress, “Oral History and Social History 

(2020): 
https://www.loc.gov/teachers/classroommaterials/lesson
s/using-history/procedure.html   

• Tenement Museum, “Oral History Lesson Plan” (2019): 
https://www.tenement.org/wp-
content/uploads/2019/02/Oral-History-Lesson-Plan-
Upper-Elementary.pdf  

 
PROCEDURE 
Opening (10 minutes) 

1. Discussion – What is “history”?  
a. Ask participants to share their thoughts about the definition of history: 

what is it? Who makes it? What sources can you use to learn about it? 
b. Explain to participants that while history textbooks talk primarily about 

the lives of explorers, war generals, etc. we all make history every day 
through the decisions we make and how we inhabit space and share our 
lives with other people. 

Activity Body (30 minutes) 
2. Participants stories from when they were a baby. 

a. Participants work in pairs to tell one another stories their family 
members have told them about when they were babies. 

b. One or two volunteers share these stories with the rest of the group. 

https://storycorps.org/discover/griot/
https://www.loc.gov/teachers/classroommaterials/lessons/using-history/procedure.html
https://www.loc.gov/teachers/classroommaterials/lessons/using-history/procedure.html
https://www.tenement.org/wp-content/uploads/2019/02/Oral-History-Lesson-Plan-Upper-Elementary.pdf
https://www.tenement.org/wp-content/uploads/2019/02/Oral-History-Lesson-Plan-Upper-Elementary.pdf
https://www.tenement.org/wp-content/uploads/2019/02/Oral-History-Lesson-Plan-Upper-Elementary.pdf
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c. Use the stories to talk to participants about how stories were passed 
down to them; someone else had to tell them about their past. How 
accurate does that make the story? What elements did the storyteller 
highlight? What might have been lost or gained through storytelling? 

3. Participants listen to oral histories from the Griot Project. 
a. Working in pairs with headphone splitters, participants listen to three 

oral histories 
b. They record observations on the Listening for the Story worksheets. 

4. Participants talk to their partner about what they heard in the interview, 
considering the items from their worksheet about what the stories considered, 
their sound quality and their importance. 

Closing (10 minutes) 
5. Class discussion – “What are characteristics of good oral histories?” 

a. Participants share what they’ve learned through the listening process. 
b. Discussion should consider: 

i. How does an interviewer frame questions to draw out an 
interviewee? 

ii. What were some aspects of quality follow-up questions? 
iii. What have they learned about sound quality through their 

listening experience? 
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1.2 Open-Ended Questions 
 
Recommended Time: 50 Minutes 
 
OVERVIEW  
In order to conduct oral history interviews, participants need to practice writing strong 
questions. Asking “open-ended” questions is essential to conducting content-rich 
interviews. Participants practice this skill on each other and determine best practices. 
Participants will be able to… Opportunities for Assessment 
Evaluate question types Student responses 
Create questions appropriate interviews Class discussions and question lists 

 
STANDARDS ADDRESSED 
• CCSS.ELA-LITERACY.SL.8.1.C - Pose questions that connect the ideas of several 

speakers and respond to others' questions and comments with relevant evidence, 
observations, and ideas. 
 

PREPARATION 
Materials 

• 1.2.1 Asking Good Questions 
PowerPoint 

Resources 
• An oral history from Story Corps 

(2020): https://storycorps.org/ 
 

 
PROCEDURE 
Opening (10 minutes) 

1. Discussion – What sort of questions are good for oral histories? 
a. Draw on oral histories listened to previously, or listen to a new one. 
b. Highlight what questions were asked and why. 

Activity Body (30 minutes) 
2. Present the “Asking Good Questions” PowerPoint. 

a. Closed- and open-ended questions 
b. Biased questions 
c. Double-barreled questions 

3. In small groups, participants ask each other a variety of open-ended and close-
ended questions and compare responses. 

4. In pairs/small groups, participants brainstorm five good interview questions 
designed to help the interviewee elaborate on specific subjects with the hopes 
of retrieving at least five pieces of information. The instructor should write the 
expected information on the board. Examples include age/grade, where they 
go to school, favorite classes, favorite things to do outside of school, careers 
they are interested in, etc. 

Closing (10 minutes) 
5. Class discussion – Share results and make a list of best practices. 

 
  

https://storycorps.org/
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1.3 Audio Recording Scavenger Hunt 
 
Recommended Time: 50 Minutes 
 
OVERVIEW  
Participants learn what works and what doesn’t while experimenting with their own 
audio recordings. This lesson forces participants to create a variety of recordings and 
then to evaluate their quality. 
Participants will be able to… Opportunities for Assessment 
Evaluate recording quality Scavenger Hunt discussion 
Judge a location on its suitability for 
recording an interview 

Class discussions and Recording 
Scavenger Hunt 

 
STANDARDS ADDRESSED 
• ISTE.6b - Participants create original works or responsibly repurpose or remix digital 

resources into new creations. 
 
PREPARATION 
Materials 

• Portable audio recording device (or phones)  
• Headphones (optional) 
• 1.3.1 Audio Recording Scavenger Hunt 

 
PROCEDURE 
Opening (15 minutes) 

1. Discussion – Basic functioning and technical overview of recorders. Though 
each set of recorders is unique, common topics you might address include: 

a. microphone location 
b. how to record and stop recording 

Activity Body (25 minutes) 
2. Recording Scavenger Hunt  

a. Participants will use the scavenger hunt to move around the location 
making recordings with specific characteristics in groups. 

b. Participants listen to those recordings and evaluate their quality. 
Closing (10 minutes) 

3. Discussion – After reviewing recordings, discuss what makes a “good 
recording location” and what other factors they should consider for better 
recording quality. Discussion should include: 

a. Microphone placement 
b. small vs. large spaces and the use of sound buffers 
c. volume, tone, speed, and voice modulation 
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1.4 Recording and Audio Editing Tutorials 
 
Recommended Time: Two 50-minute periods 
 
OVERVIEW  
In this lesson, participants record a practice interview, then learn how to use audio 
editing software. This practice run for conducting oral history interviews will also inform 
how they conduct interviews and give them an opportunity to see the entire process 
from start to finish in a short amount of time. The remainder of the curriculum is 
essentially a more elaborate version of what they’ll work through in this lesson. 
 
Participants will be able to… Opportunities for Assessment 
Record an interview with another student Audio recordings 
Explain the basic functions of audio 
editing software 

Class discussion, teacher questioning, 
and completed audio projects 

Create a unique edited audio recording 
using filters/effects 

Completed audio project. 

 
STANDARDS ADDRESSED 
• ISTE.6b - Participants create original works or responsibly repurpose or remix digital 

resources into new creations. 
• ISTE.6c - Participants communicate complex ideas clearly and effectively by 

creating or using a variety of digital objects such as visualizations, models or 
simulations. 

 
PREPARATION 
Materials 

• Speakers or headphones 
• Computers  
• 1.4.1 Audacity Tutorial 
• 1.4.2 Soundtrap Tutorial 

 
PROCEDURE 
Opening (5 minutes) 

1. Discussion – Give an overview of the lesson and introduce software.  
Activity Body (30 minutes) 

2. In pairs or small groups, participants review the previous lesson by writing up 
three basic interview questions. 

3. They then practice interviewing and recording one another. 
4. Participants use the resultant recordings to experiment with the software and 

completed the audio editing tutorial. 
Closing (15 minutes) 

5. Discussion – Share some edited clips with the class, discussing how they were 
made. 
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1.5 Developing Interview Skills 
 
Recommended Time: 50 Minutes 
 
OVERVIEW  
To prepare to conduct the “official” interviews, participants will need to further practice 
developing questions and using effective interviewing techniques. In this lesson, by 
practicing and providing one another feedback, participants will learn how to conduct 
proper oral history interviews. They will also finalize a script of question for interviews.  
 
Participants will be able to… Opportunities for Assessment 
Use professional oral history interview 
techniques Practice interview activity 
Evaluate someone else’s interview skills  

 
STANDARDS ADDRESSED 
• CCSS.ELA-LITERACY.SL.8.2 - Analyze the purpose of information presented in 

diverse media and formats (e.g., visually, quantitatively, orally) and evaluate the 
motives (e.g., social, commercial, political) behind its presentation. 

 
PREPARATION 
Materials 

• Buzzers, such as from the game Taboo or anything that makes noise 
• 1.5.1 Example Interview Script 

 
PROCEDURE 
Opening (5 minutes) 

1. Discussion – Review of open-ended questioning. 
Activity Body (25 minutes) 

2. Discussion – What makes a good oral history interviewer? 
a. Recommendation: Model good and bad interviewing 
b. Good Interviewing: 

i. Silent after asking a question 
ii. Asks open-ended questions 
iii. Waits 5 seconds after interviewee answers before they ask 

another question 
iv. Uses nonverbal cues to make interviewee comfortable 

3. In groups of three, participants practice being interviewers. 
a. One person is the interviewer 
b. One person is the interviewee 
c. One person monitors the interviewer and “buzzes” them when they 

demonstrate poor interviewing skills (cutting the interviewee off, making 
noise, etc.) 

Closing (20 minutes) 
4. Class activity – Developing Questions 
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a. Participants work in pairs to determine a series of questions that would 
be helpful for exploring the generalized topic that pertains to their 
podcasts (e.g. food in East St. Louis). 

b. The group comes back together to provide feedback on questions. 
c. The group votes on a final set of questions that will comprise the 

interview script. 
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1.6 Conducting Interviews 
 
Recommended Time: 50 Minutes 
 
OVERVIEW  
After practicing interview skills, recording audio, and seeing an overview of the full oral 
history process, participants conduct interviews. You might consider taking participants 
to a nursing home or senior center or inviting guests to come to you. It may be possible 
to have participants conduct them at home with family. 
 
Participants will be able to… Opportunities for Assessment 
Conduct an oral history interview 

Interview recordings 
Produce recordings with high sound 
quality 
Ask appropriate follow-up questions 
during an interview 

 
STANDARDS ADDRESSED 
• ISTE.6b - Participants create original works or responsibly repurpose or remix digital 

resources into new creations. 
• ISTE.6c - Participants communicate complex ideas clearly and effectively by 

creating or using a variety of digital objects such as visualizations, models or 
simulations. 

 
PREPARATION 
Materials 

• Audio recording equipment 
• Headphones, if applicable  
• Printed interview scripts for each interviewing team 
• Interviewees 

 
PROCEDURE 
Opening (5 minutes) 

1. Briefly review recording skills, possible technology pitfalls, and interviewing 
before the interviews begin. 

Activity Body (40 minutes) 
2. Conduct interviews 

a. Have interviewers work in pairs. To give them experience, it is best if 
they have the opportunity to interview at least two people. 

b. They will take turns in the role of sound technician and interviewer.  
Closing (5 minutes) 

3. Collect all recordings before participants leave so you do not lose the files. 
They may need to turn in recorders, download files, or email them to you. 
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1.7 Indexing Oral History Interviews 
 
Recommended Time: 50 Minutes 
 
OVERVIEW  
In order for the interviews to be usable by all participants, the files must be indexed to 
explain what content is discussed during particular times within the interview. After 
indexing their interviews, participants will a better understanding of what each interview 
contains, and will be able to quickly find relevant audio. 
 
Participants will be able to… Opportunities for Assessment 
Define indexing as it relates to 
interviewing 

Class discussion and indices 

Select important pieces of information 
from interviews Indices 

 Summarize interview answers 
 
STANDARDS ADDRESSED 
• ISTE.3b - Participants evaluate the accuracy, perspective, credibility and relevance 

of information, media, data or other resources. 
• ISTE.4b - Participants select and use digital tools to plan and manage a design 

process that considers design constraints and calculated risks. 
• ISTE.6b - Participants create original works or responsibly repurpose or remix digital 

resources into new creations. 
• CCSS.ELA-LITERACY.SL.8.2 - Analyze the purpose of information presented in 

diverse media and formats (e.g., visually, quantitatively, orally) and evaluate the 
motives (e.g., social, commercial, political) behind its presentation. 

 
PREPARATION 
Materials 

• Computers  
• Headphones and splitters 
• Method for participants to access files (e.g. Google Drive, Dropbox, flash 

drives, or a pre-loaded computer) 
• 1.7.1 Interview Index 

 
PROCEDURE 
Opening (10 minutes) 

1. Discussion – Oral History Interview Indices. Guiding questions: 
a. What topics did each interviewee talk about? 
b. What methods can you use to quickly find information? You might 

discuss indices in textbooks as an example or searching online as 
similar to needing “keywords” in the audio to make it searchable. 

Activity Body (30 minutes) 
2. In pairs, participants index sample interviews: 
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a. One student is in charge of running the computer and one student 
writes. 

b. They listen to the same interview at the same time and use an “indexing 
log” with timestamps and a short summary to record pertinent. The log 
should also include the name of the interviewee and interviewer. 

Closing (10 minutes) 
3. Discussion – Comparing and contrasting student indexes. 

a. How detailed should we be? 
b. How accurate is our time keeping? 
c. Why is this useful? 
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1.8 Introducing Podcasts and Choosing a Central Question 
 
Recommended Time: 50 Minutes 
 
OVERVIEW  
Podcasts are a series of audio recordings on a common theme, typically distributed 
online. Podcasts often contain music and audio effects, interviews, and scripted 
speaking. In this lesson, participants will be introduced to podcasts and begin to 
conceptualize the story they might tell. During this pivotal lesson, students also begin 
working in their podcasting teams, practicing collaboration skills and working to come to 
a consensus about the central question that will frame their podcasts. Instructors may 
direct participants to their own topics and/or podcasts, or have the group collectively 
share a theme and make several episodes that contribute to the overarching theme.  
 
Participants will be able to… Opportunities for Assessment 
Define podcast Student responses 
Identify possible topics for an in-depth 
podcast relating to oral histories 

Group possible topics lists, and podcasts 

 
STANDARDS ADDRESSED 
CCSS.ELA-LITERACY.CCRA.SL.1 - Prepare for and participate effectively in a range of 
conversations and collaborations with diverse partners, building on others' ideas and 
expressing their own clearly and persuasively. 
ISTE.4a - Students know and use a deliberate design process for generating ideas, 
testing theories, creating innovative artifacts or solving authentic problems. 
 
PREPARATION 
Materials 

• Large sheets of paper  
 

Resources 
• A Sample podcast, such as We Live 

Here, St. Louis Public Radio 
http://www.welivehere.show/  

 
PROCEDURE 
Opening (15 minutes) 

1. Discussion – “What is a Podcast?” 
a. Define podcast for students. 
b. Play a sample podcast. Some guiding questions: 

i. What was the podcast about? 
ii. What question did the podcast answer? 
iii. What tools did the podcast use to tell a good story? 

Activity Body (20 minutes) 
2. Participants are assigned to podcasting groups that they will work with as they 

complete their podcasting projects. 
3. Groups will brainstorm open-ended questions they could use to frame their 

podcasts. They choose a central question for their podcast after judging each 
question on their list based on the following criteria: 

http://www.corestandards.org/ELA-Literacy/CCRA/SL/1/
http://www.welivehere.show/
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a. Is it interesting? 
b. Did it come up in the oral history interviews? 
c. Would there be other sources to find information about it? 

4. The group then comes up with a list of smaller, related questions that they will 
need to research in order to build the podcast and lists them on the left side of 
large sheet of paper. These more focused questions will help them think about 
the specifics they’ll need to learn. Examples: 

a. What is soul food?  
b. Where did soul food begin?  
c. How has soul food changed?  
d. How does each region cook soul food differently?  
e. What restaurants have been good places to eat soul food?  
f. How do the dishes prepared relate to seasons and holidays? 

Closing (15 minutes) 
5. Groups share their “Podcast Theme Question” and receive feedback. 
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1.9 Podcast Research 
 

Recommended Time: 50 Minutes 
 
OVERVIEW 
Participants are introduced to the rudiments of selecting relevant research across 
several source formats. The teacher pre-selects source materials relevant to local 
history from books, newspapers, radio, online, and virtual references and students 
practice using the resources to find useful additional information for inclusion in their 
podcasts.  
 
STANDARDS ADDRESSED 
• ISTE.3a - Participants plan and employ effective research strategies to locate 

information and other resources for their intellectual or creative pursuits. 
• ISTE.3b - Participants evaluate the accuracy, perspective, credibility and relevance 

of information, media, data or other resources. 
• CCSS.ELA-LITERACY.SL.8.2 - Analyze the purpose of information presented in 

diverse media and formats (e.g., visually, quantitatively, orally) and evaluate the 
motives (e.g., social, commercial, political) behind its presentation. 
 

PREPARATION 
Materials 

• Computers 
• Large sheets of paper with 

research questions developed 
during previous lesson 

• File that contains research links 
students will need to conduct 
beginning research on their 
podcast (DESTL used a Google 
Document with Links to all 
research resources to make the 
second half of the lesson proceed 
efficiently). 

• Research Guide Sheets, including: 
1.9.1 Finding Information in Books, 
1.9.2 Finding Information in  
Newspapers, 
1.9.3 Finding Information on the 
Radio 
1.9.4 Finding Information Online 
1.9.5 Finding Information Using 
Virtual References. 

Resources 
• A Sample podcast, such as We Live 

Here, St. Louis Public Radio 
http://www.welivehere.show/  

• New York Times: 
https://www.nytimes.com/  

• NPR: https://www.npr.org/  
• A selection of books related to their 

podcasts’ topics chosen in advance, 
for example, Andrew Theising’s Made 
in USA: East St. Louis, the Rise and 
Fall of an Industrial River Town (2003) 

• Websites, local newspapers, radio 
station archives, directories or other 
resources where students can easily 
research local history 

 
 

http://www.welivehere.show/
https://www.nytimes.com/
https://www.npr.org/
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PROCEDURE 
Opening (15 minutes) 

1. Discussion – Why do you conduct research using sources from multiple 
formats? 

a. Share an example of a radio story and a snippet from a book that 
highlights how content is often shaped by the format in which it appears. 

b. Ask students what differences they notice. They might highlight: 
i. length of the source. 
ii. detail of the source. 
iii. the kind of story discussed. 
iv. the purpose. 

Activity Body (25 minutes) 
2. Individually, or in pairs, participants will research the questions they crafted in 

lesson 1.7 using guiding worksheets for each source format:  
a. Books (books on the topic you’ve selected in advance for students). 
b. Newspaper (New York Times or Newspaper.com). 
c. Radio (NPR). 
d. Websites (websites of local historians). 
e. Virtual Reference Resources (Gale Reference). 

NOTE: This will not be the only research that participants do. Introducing them to the 
resources available will allow them to more easily go back to find information as they 
make their podcasts. 
Closing (10 minutes) 

3. Groups each share two to three things they have learned from conducting their 
research and receive feedback. 
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1.10 Podcast Story Mapping 
 
Recommended Time: 50 Minutes 
 
OVERVIEW  
In order to help groups develop an agreed-upon central plan, participants make a post-it 
note story map in this lesson. Story maps are an easy way to organize main elements of 
a story with the opportunity to imagine alternative sequencing by moving the order of 
the notes and adding and subtracting content easily. After creating their story maps, 
participants can work independently or in smaller groups to complete their podcasts, 
allowing them to practicing twenty-first century skills central to collaboration and project 
management. 
 
Participants will be able to… Opportunities for Assessment 
Identify an appropriate audience for class 
podcasts 

Class discussion 

Create a story map to plan the podcasts’ 
logical organization 

Story maps 

 
STANDARDS ADDRESSED 
• ISTE.4a - Participants know and use a deliberate design process for generating 

ideas, testing theories, creating innovative artifacts or solving authentic problems. 
• ISTE.6b - Participants create original works or responsibly repurpose or remix digital 

resources into new creations. 
• ISTE.6c - Participants communicate complex ideas clearly and effectively by 

creating or using a variety of digital objects such as visualizations, models or 
simulations. 

• CCSS.ELA-LITERACY.SL.8.2 - Analyze the purpose of information presented in 
diverse media and formats (e.g., visually, quantitatively, orally) and evaluate the 
motives (e.g., social, commercial, political) behind its presentation. 

 
PREPARATION 
Materials 

• Indices from oral history interviews 
• Poster board or large wall post-its 
• Post it notes of different colors 
• 1.10.1 Podcast Tasks to Complete 

 
PROCEDURE 
Opening (5 minutes) 

1. Discussion – Who is the audience for our podcasts?  
a. Who do the participants assume will listen to their podcasts? 
b. What would their audience most like to know? 
c. To what does their audience most respond? 

Activity Body (40 minutes) 
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2. Each group will work together to plan out their podcast using a big poster 
board and post-it notes with specific plans for podcast content. Each color of 
post-it will represent a different kind of audio (student voice, interview clip, 
music/ambient noise). Participants should specifically note where their 
research from lesson 1.9 can add useful information to the podcast: 

a. Intro 
b. Interview clips 
c. Transitions 
d. Music 
e. Outro 

2. For the remainder of the day, groups use “task sheet to assign tasks required 
to complete the podcasts. Help them consider how much time they have to 
complete the podcasts and how they might assign tasks by the day. 

Closing (5 minutes) 
3. Group review – “What did I do today, and what am I going to do tomorrow to 

help complete our podcast?” 
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1.11 Creating Podcasts 
 
Recommended Time: Three 50 Minute sessions 
 
OVERVIEW  
The remainder of the module can extend over several days, but at least 3 sessions is 
ideal. Teams will open and end the session by checking in on their progress, but they 
may spend the rest of their time working on their own or with a partner. This system 
helps participants maintain a sense of ownership over their work and have a clear 
sense of their role in the project. It also provides instructors with an opportunity to check 
in with groups on a daily basis and to monitor their progress. 
 
Participants will be able to… Opportunities for Assessment 
Choose and export audio clips 

Podcasts Record intros, outros, and transitions 
Edit a podcast using previous recordings 

 
STANDARDS ADDRESSED 
• ISTE.1b - Participants build networks and customize their learning environments in 

ways that support the learning process. 
• ISTE.4a - Participants know and use a deliberate design process for generating 

ideas, testing theories, creating innovative artifacts or solving authentic problems. 
• ISTE.6b - Participants create original works or responsibly repurpose or remix digital 

resources into new creations. 
• ISTE.6c - Participants communicate complex ideas clearly and effectively by 

creating or using a variety of digital objects such as visualizations, models or 
simulations. 

• CCSS.ELA-LITERACY.SL.8.2 - Analyze the purpose of information presented in 
diverse media and formats (e.g., visually, quantitatively, orally) and evaluate the 
motives (e.g., social, commercial, political) behind its presentation. 

 
PREPARATION 
Materials 
• Headphones with splitters 
• Recording equipment or phones 
• Computers  
• Story maps 
• Audio editing software 

(Audacity/Soundtrap) 
• Audio Editing Tutorials 
• 1.10.1 Podcast Tasks to Complete 

Resources 
• Online databases where students can 

obtain loyalty-free music and sound 
effects, such as Freesound or 
IncompeTech. 

 

 
PROCEDURE 
Opening (5 minutes) 

1. Group review – “What am I going to do today to help complete our podcast?” 

https://freesound.org/
https://incompetech.com/
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a. Have participants review the task sheet and coordinate their 
responsibilities for the day.  

b. Decide together how they would like to split up the work and whether 
they prefer independent or collaborative labor throughout the period. 

Activity Body (40 minutes) 
2. Participants work on various required tasks to complete the podcasts, 

including: 
a. Identifying and clipping audio from oral history interviews. 
b. Writing and revising scripts for the intro, transitions, and outro. 
c. Recording intro, transitions, and outro. 
d. Finding music (set a time limit, as this becomes distracting). 
e. Joining clips together in audio editing software. 
f. Mixing audio together and smoothing transitions. 
g. Updating story maps. 

3. Check in with groups as they work to monitor progress and guide them. 
Closing (5 minutes) 

1. Group review – “What did I do today, and what am I going to do tomorrow to 
help complete our podcast?” 

 
Note: If there is time, on the final day, have a celebration and listen to all of the 
Podcasts together. 
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Evidence of Learning 
 
Performance Tasks 

 
• Interview questions – Participants will generate a set of questions to ask during 

oral history interviews. These questions will reflect their understanding of open-
ended questioning techniques. 

• Oral History Interview Recordings – Participants will generate oral history 
interviews, demonstrating their skills in audio recording, as well as their usage of 
interpersonal communication skills and non-verbal cues, such as providing 
enough time for answers and follow-up questioning. 

• Podcast Storyboards – Participants groups will complete storyboards while 
planning their podcasts. These storyboards should be updated throughout the 
project. 

• Podcasts – Participants will create podcasts as the summative project. These 
podcasts will include audio editing skills, planning skills, as well as collaboration 
and a variety of writing and speaking skills. 
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Oral History Interview Rubric 
 

  

Score Interview 
questions  

Questioning 
Skills  

Recording 
Quality  

Organization and 
presentation  

2 • All interview 
questions are 
open-ended and 
relevant for 
interviewee 

• Several follow-
up questions are 
asked to clarify 
or deepen 
answers  

 

• All interview 
questions are 
asked clearly  

• Participant 
remains quiet 
during entire 
interviewee 
answer  

• Participant waits 
after each 
question for 
interviewee to 
finish  

• Voices are clear 
and 
understandable 
throughout 
recording  

• Few, if any, non-
interview sounds 
can be heard on 
recording  

 

• Presentation of 
data is clear and 
organized  

 

1 • Some interview 
questions are 
open-ended and 
relevant for 
interviewee  

• Few follow-up 
questions are 
asked to clarify 
or deepen 
answers. 

• Most interview 
questions are 
asked clearly  

• Participant 
remains quiet 
during entire 
interviewee 
answers  

• Participant often 
waits after each 
question for 
interviewee to 
finish  

• Voices are 
somewhat clear 
and 
understandable 
throughout 
recording  

• Some non-
interview sounds 
can be heard on 
recording 

• Presentation of 
most data is 
clear and 
organized 

0 • Interview 
questions are 
not open-ended 
or relevant for 
interviewee  

• No follow-up 
questions are 
asked to clarify 
or deepen 
answers 

• Few or no 
interview 
questions are 
asked clearly  

• Participant does 
not remain quiet 
during entire 
interviewee 
answer  

• Participant does 
not wait after 
each question 
for interviewee 
to finish  

• Voices are not 
clear and 
understandable 
throughout 
recording  

• Many non-
interview sounds 
can be heard on 
recording 

• Presentation of 
little or no data is 
clear and 
organized 
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Worksheet and Tutorial Appendix 
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1.1.1 Listening for the Story 
 
Complete the tables below for each of the interviews you are assigned. Include 
significant time stamps next to the bits of information you list below. 
 
Interview 1 
Name: 
Sound quality: 
 
Ambient noises: 
 
Interesting facts/details: 
 
 
 
Places mentioned: 
 
 
Things you’d like to know more about: 
 
 
 
 

 
 
Interview 2 
Name: 
Sound quality: 
 
Ambient noises: 
 
Interesting facts/details: 
 
 
 
Places mentioned: 
 
 
Things you’d like to know more about: 
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1.2.1 Asking Good Questions PowerPoint 
  



ASKING GOOD QUESTIONS



◼What did you eat for breakfast this morning?
◼How do you get to the grocery store?
◼Do you spend time with friends after school?
◼What is your favorite thing to do?
◼Describe your ideal weekend
◼Tell me a story about a time when you had fun.

QUESTIONS TO ASK YOUR PARTNER



Closed-ended questions only have one answer:
◼Do you like basketball?
◼Did you have fun at the park?
◼How many donuts did you eat?
◼How did you get to school today?

CLOSED-ENDED QUESTIONS



Open-ended questions are questions that lead to 
longer, detailed answers. They do not have 
one-word answers: 
◼What is your favorite place in the city? 
◼What do you remember about growing up in East 

St. Louis?
◼How has the city changed since you’ve been here?

OPEN-ENDED QUESTIONS



Biased questions suggest an answer in the question 
itself:

▪Do you agree that there isn’t good food in East 
St. Louis ?
Revised question: Where do you like to eat in 
the city and why?
With the follow up…
Where don’t you like to eat in the city and 
why?

BIASED QUESTIONS



Double-barreled questions ask more than one 
thing. 

◼ What environmental problems does East St. 
Louis have, and how should the city 
government fix them?

◼ Make sure to ask one question at a time and 
prepare follow-up questions that anticipate a 
variety of answers.

DOUBLE-BARRELED QUESTIONS





Happy Interviewing!
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1.3.1 Audio Recording Scavenger Hunt Worksheet 
 

Use your recorder to record a clip for each task on the list.  
Record # Recording Task Notes 

 With MIC Sensitivity on High, answer the question “why did 
you join Digital East St. Louis?” 

 

 With MIC Sensitivity on Low, have your partner answer the 
question “why did you join Digital East St. Louis?” 

 

 Record saying your address while far away from your 
recorder. 

 

 Record your partner saying their address while very close to 
the recorder. 

 

 Make a 2-minute recording outside.  

 Make a recording of a one-question interview with your partner 
somewhere with an echo. 

 

 Record answering a question while being too loud.  

 Record answering a question while being too quiet.  

 Make a recording talking about a restaurant near someone 
that’s talking. 

 

 Explain what your favorite class was last year near a machine 
making noise. 

 

 Write down a question and your answer. Make a recording 
saying what you wrote down. 

 

 Make a recording talking to an adult.  

 Make a recording with the recorder sitting on a table in front 
of you. 

 

 Record your partner counting to 20 while moving the recorder 
around. 
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1.4.1 Audacity Tutorial 
 

This tutorial covers recording and editing audio using a program called Audacity. Audacity is an 
open source (FREE) audio editor that can be used to edit interviews, podcasts, music, and any 
other sound files.  You can download it at home and use it for free 
(https://www.audacityteam.org/download/). 
 
Recording and Playing Audio Files in Audacity 

 
 
Record  
Use the record button to record your audio. Once you press record, speak clearly into your 
microphone so that you can see the waves on the screen change according to your voice. 
 
Pause  
Use the pause button to take a break from recording. If you press pause, you can come 
back to the recording and still record on the same track. 
 
Stop  
Use the stop button when you have finished recording and are ready to save or export the 
file. 
 
Opening an Audio File 
File > Open... 
Open imports each file you select into its own new project window. 

https://www.audacityteam.org/download/
http://manual.audacityteam.org/man/file_menu.html#open
http://manual.audacityteam.org/man/file_menu.html#open
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Importing an Audio File 
File > Import > Audio… 
Select File > Import > Audio, then choose one or more audio files. Audacity will import the 
selected file(s) into the existing project. This is useful to bring the content of one or more audio 
files into a project that already contains audio (for example, to mix several audio files together 
into a mashup). 
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Saving Your Project  
You save a “project”, not a file—until you are completely finished with your editing. When you 
are finished, you will export a new file. But until then, you will just go on saving your project as 
many times as necessary to avoid losing your work. 

 
Making .mp3 files 
Exporting in .mp3 format turns your project into an .mp3 file. You can choose to export all of the 
tracks in your project, a single track, or any part of a track.  
 

 

1) File > Export Audio... It exports all the audio tracks in the project.  

http://manual.audacityteam.org/man/file_menu.html#export
http://manual.audacityteam.org/man/audio_tracks.html
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1. Choose a destination and a name for your file. 

2. Choose “Save as type” as MP3. 

3. Click Save. 
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2) Export a clip 

File > Export Selected Audio... 
Exports only the selected audio. 
 

 
 

1. Choose a destination and a name for your file. 

2. Choose Save as type as MP3. 

3. Click Save. 
 
 
 
 
 
 
 
 
 

 
  

http://manual.audacityteam.org/man/file_menu.html#export_selection
http://manual.audacityteam.org/man/file_menu.html#export_selection
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Mixing an Audio Track with a Background Music Track 
Import a Narration (Main Audio Track): 
Choose File > Import > Audio and open the audio track that you will mix with background 
music. 
 

 
 
Import the background music file: 
Choose File > Import > Audio and open the background music file you've chosen for the 
project. Audacity imports the music file into your project and puts it in its own stereo track. 
 

 
 
Rename the tracks to “Narration” and “Background” for conventions by clicking on the arrow 
button on each of the names and then clicking on the name option to rename. 
 
Mute and Solo: 
These buttons are located at the Track Control Panel at the left of each track. Clicking the 
"Solo" button will cause only that track to be heard when you press Play. Clicking the "Mute" 
button will turn that track off - it will not be included in the mix when you press the Play button. 
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Cutting the Narration Track/Actual Audio Track: 
Start by clicking the "Solo" button on the narration track. Assuming that we want to cut the 
narration into three separate segments, find the spots on the track to cut the narration track, 
between which we would like to include our background music.  
 
Use the selection tool to find the points on the track. Choose Edit > Clip Boundaries > Split - a 
split line appears. There are now two clips on the narration track. Similarly, put a split point 
between the second and third portions of the narration. 
 
Click on the solo button again before you move to the next step to hear both the narration and 
music tracks. 
 

 
 
Marking places on the Background music where we want the narration track to start:  
Our goal is to cut the narration to fit the music. We need to pick the spots in the background 
music track where we want the three clips to start. Start by clicking the "Solo" button on the 
background music track.  
 
Identify the point in the background music track where you want the narration to begin. Click at 
that point with the Selection Tool.  
 
Choose Tracks > Add Label at Selection. Type a name for the label, for example "First 
Narration". 
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Similarly, identify the points in the background music track where you want the second and third 
narration clips to begin, and create labels at those points. 
 

 
 
Click on the solo button again before you move to the next step to hear both the narration and 
music tracks. 
 
Move Clips as per the Labels: 

Using the Time Shift Tool  drag the third narration clip so that the start of the clip lines up 
with the third label. Audacity will help you line this up perfectly - when the start of the clip lines 
up with the third label a yellow Boundary Snap Guide will light up. Similarly, drag the second 
narration clip to line up with the second label, and drag the first narration clip to line up with the 
first label. 
 

 
 

http://manual.audacityteam.org/man/boundary_snap_guides.html
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Adjust volumes of the tracks: 

Select the Envelope Tool  from the Tools Toolbar. In the music track, click to create a 
control point a second or so before the first narration clip begins. Click to create a second 
control point just as the narration starts. Drag the second control point down to reduce the 
volume of the music track. Adjust the first and second control points to get the length and depth 
of the fade you want. In a similar manner create the fade up at the end of the first narration clip. 
Continue in this manner doing the fades on the music track for each clip in the narration track. 
You can always go back and change the fades. 
 

 
 
Check Your Mix 
Play the mix and check after adjusting the volume. 
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1.4.2 Soundtrap Tutorial 
 

You will be working with Soundtrap’s audio studio to create the podcast. 
 
Logging In 
 
First visit soundtrap.com. Then click the Log In button on the top right. You will then get 
this screen: 
 

 
Choose Log in with Google. This will connect with your Google account on your 
Chromebook. 
 
You will then a screen like this: 

https://www.soundtrap.com/
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Click Studio at the top right. 
 
It then asks you to pick a template: 

 
Choose Blank. 
 
You are now in the studio, which is where you will be making the podcast. 
 
Importing audio 
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First, we need to add some audio to the program. Let’s start with your interview files. 
 

 
Click Add New Track. 

 
Select Voice & microphones. 
 
You now have an empty track for voice recordings. 
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If you hover your mouse over the white box on the left side of the track, a gear will 
appear. Click the gear, and then click Import… 
 
Then, navigate to wherever your audio file is stored on your Chromebook. Click the file 
and then click Open. 
 
Your audio file should now be in Soundtrap, and will look like this: 

 
You can add multiple audio files as needed, including music. Just repeat the previous 
process. Here is a project with two audio files: 

 
 
Playing audio 
The first audio file I added is 25 minutes long and not fully visible unless I zoom out. 
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You can zoom in and out on the audio using the magnifying buttons on the lower right: 

 
Here is the studio fully zoomed out: 

 
If you’re zoomed in, you can also use the scroll bar at the bottom to move forwards and 
backwards through the audio: 
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Below the scrollbar are the playback controls: 

 
The numbers at the far left represent your playback position, so if it reads “01:03.5” it 
means you are at one minute, three seconds, and five milliseconds. 
 

Next to the numbers is the record button. You will not be using this button. 
 

Next is the stop button. If you press the button while it is playing, the audio will 
stop. 
 

Next is the rewind button. It moves the audio back a few seconds. 
 

Next is the play button. Press this button to play the audio. 
 

Last is the fast-forward button. It moves the audio forward a few seconds. 
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Try playing your audio for a short time, then press stop. 

 
Notice as you’re playing how the purple, vertical line moves to the right. This line is your 
playback position within the audio. 
 
If you have multiple audio files on top of each other, like in this screenshot, notice also 
how both files play at the same time. 
 
Editing 
Seeing Audio 
Before you start editing, it is helpful to recognize what is going on in in the audio track 
just by looking at it. Digital audio is represented visually as a wave. The higher the 
wave, the louder the audio: 

 
Here is a closeup of the audio. The circled areas have higher waves, so they represent 
when the person is talking. The shorter waves outside the circles are the quiet parts 
when the person isn’t talking. 
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Now compare the two audio tracks. Notice how the second track, also a voice 
recording, has even higher waves than the first. Therefore, the second file is louder than 
the first. 
 
Adjust track volume 
It is important for multiple audio files to have approximately the same volume. 
Soundtrap lets you adjust the volume of each individual track. 

 
If you look at the right side of the track, you will notice a volume adjuster. In this image, 
both tracks are at the loudest volume. If you click the adjuster, you can raise or lower 
the volume to the level you want. 

 
Here, I have lowered the volume of the second track, making it and the first track 
roughly the same volume. 
 
Splitting Audio 
Probably the most useful tool in audio editing is the ability to split an audio track into 
multiple parts. This also lets you delete parts of the audio you don’t want. 
 
Here I am going to split the first track and put audio from the second track in between 
the split. 
 
First, get the vertical, purple line at the start of the audio section you want to cut. I’m 
making sure to put it when a person isn’t talking: 

 

 



 

51 
 

 
Next, click on the first track so that it is brighter, then go to the top and click Edit and 
then Split Region: 

 
Now the first track is split into two audio segments at the purple line:

 
Now go to the end of the section you want to remove from the first track and do the 
same thing so you now have three segments: 
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Now select the segment you want to remove and press Delete. The segment is now 
gone: 
 

 
 
Now we want to get the desired audio from the second track. Split the track into three 
segments as we did with the first track: 
 

 
 
This time however, click the segment to the left of the desired track and press Delete, 
and click the segment to the right of the desired track and press Delete. 
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Moving Audio 
Now that we have the audio we need, we just need to move it to the right spot. Click on 
the second track’s segment and drag it to the right until it lines up with the end of the 
first track’s first segment: 
 

 
 
Now notice how the second track’s segment is still longer than the blank space in the 
first track. Click and drag the first track’s second segment until the blank space is the 
same length as the second track: 
 

 
 
The two tracks are now properly mixed. 
 
You can then add the audio from track two again as a third track to keep getting audio. 
 
Moving forward, you may find it easier to separate all the segments you want from the 
audio you have and delete all the unnecessary parts. You can then move the audio 
around until you have it in the order you want. 
 
Saving 
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Once you are done editing, you can export a final audio file from Soundtrap. 
 
First, click the save button at the top:

 
 
This may take awhile, but once it is done the project will then save in Soundtrap, 
meaning you can access it again from the website. 
 
Now we can export the audio. Click File, then Export, and finally Export project to 
mp3 file: 

 
 
It may give you this message: 
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If it does, you will have to wait a bit until it is ready to export. You can tell if it is still 
mixing if it says this at the top: 

 
Once it is ready, the mp3 file will download. 
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1.5.1 Example Interview Script 
 
Remember Good Interviewing Skills:

• Stay silent during the interview 
• Pause between their answer and 

your next question 
• Don’t forget to ask “Why?” 

• Use good nonverbal 
communication and body 
language 

• Speak loudly and clearly 
• Speak slowly

1. For a sound check, ask the person you are interviewing to state their name, and 

then spell it. 

2. What was school like for you as a child? 

3. What educational experiences most impacted your life? 

4. How did your experience as a student at school mold you as a person? 

5. What types of dishes did you and your family, or community, make growing up? Did 

you have special ones for holidays and events? 

6. What popular restaurants were around when you were growing up and what did they 

serve? 

7. What music have you listened to through your years? 

8. What experience have you had with local music? 

9. How have fashion trends changed over time? 

10. Did being into fashion matter in your time? 

11. What sports were the main focus of East St. Louis? Why? 

12. Were women allowed to participate in sports in East St. Louis? If so, which ones 

were allowed? 

13. In your words, how would you say the government is addressing the pollution 

situation? Why? 

14. Has the pollution and littering benefitted the families of East St. Louis or placed 

burdens on the families? Why? 

15. ___________________________________________________________________ 

16. Is there anything that I missed? 
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1.7.1 Interview Index 
 
Interviewee Name _________________________  Indexer Name ___________________________ 

Start 
Time 

End Time Description Category (Circle) 

0:19 0:38 Talking about Dunbar Elementary Education Food Fashion Environ Music Sports 
0:41 0:57 Talking about summer camps Education Food Fashion Environ Music Sports 
23sec 3minutes Talking about education education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
   Education Food Fashion Environ Music Sports 
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1.9.1 Finding Information in Books 
 
Go through one book at a time, completing the following tasks. 

1. Scan the Table of Contents at the front of the book for any references to your 
research question and/or search terms. 

2. Look for your search terms in the alphabetical index at the back of the book. 
3. There might not be something worthwhile in every book. Whenever you find an 

interesting fact or detail that applies to your research question, write down the 
title of the book, the page number where it occurs, and a brief description of what 
you’ve learned in the following chart. 

Book Page(s) Information for Podcast 

 
 

  

 
 

  

 
 

  

 
 

  

 
How might you use this research in your podcast? 
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1.9.2 Finding Information in Newspapers 
 

1. Go to the New York Times link in the links file.  
2. Try your search terms and pairings in the search box at the top right of the 

screen. Make sure you put quotation marks around terms that contain multiple 
words, like “Madison County.” 

3. Notice that at the top of the listing, you can sort the findings by Newest, Oldest, 
and Relevance. You may want to sort by newest or oldest if history is a factor in 
your research. Otherwise, relevance may be the most effective. 

4. Scan through the list of findings, and skim those articles that seem applicable to 
your research question. 

5. Read more closely when you find an article that will help you answer your 
questions. Note that we do not have free access to all articles. 

6. Document your findings in the chart below. 
 

Article Title Date Information for Podcast 

   
 

 
 

  
 

 
 

  
 

 
 

  

 
How might you use this research in your podcast? 
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1.9.3 Finding Information on the Radio 
 

• Visit the National Public Radio link in the links file. 
• Click on the search icon at the top right of the screen. 
• Try your search terms and pairings in the search box at the top right of the 

screen. Make sure you put quotation marks around terms that contain multiple 
words, like “Madison County.” 

• The database has a sort by “best match” and a “sort by date” option. You may 
want to try both sorting methods. 

• Scan through the list of findings, and skim those transcriptions/radio broadcasts 
that seem applicable to your research question. Feel free to listen rather than 
read. 

• Document your findings in the chart below. Be sure to add any timestamps that 
will help you return to useful information. 

 
Story Title Date Information for Podcast Timestamps 

   
 

 

 
 

  
 

 

 
 

  
 

 

 
 

   

 
How might you use this research in your podcast? 
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1.9.4 Finding Information Online 
 

• Navigate to Google and try your search terms using Google’s search engine.  
• Skim the listed returns for relevant information. 
• Add what you find to the chart below. 

 
Website Title URL Information for Podcast 
   

 

 
 

  
 

 
 

  
 

 
 

  

 
 

  

 
 

  

 
 

  
 
 
 

 
How might you use this research in your podcast? 
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1.9.5 Finding Information Using Virtual References 
 

• Visit an assigned computer to try searching in the Gale Virtual Reference Library. 
• In many cases, you can listen as well as read. 
• Add important findings in the chart below. 

 
Article Title Reference Book Information for Podcast 
   

 

 
 

  
 

 
 

  

  
 

 

 
How might you use this research in your podcast? 
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1.10.1 Podcast Tasks to Complete 

Task Who Description Completed 
Story map  Plan your podcast with your group. Make a story map with a poster and post-it 

notes with all of the content that your podcast will need. 
 

Write the Intro  Make a script for the introduction of the podcast. This should include your 
names, a bit about the project, and your podcast theme question. 

 

Record the Intro  Record the scripted introduction, then upload it. Make sure to name it correctly.  
Write the Outro  Make a script for the end of the podcast. It should include a brief summary, an 

“answer” to your theme question, and a goodbye. 
 

Record the Outro  Record the scripted outro, then upload it.  

Write Transitions  Make a script for the transitions between clips in the podcast.  

Record Transitions  Record the scripted transitions, then upload them. Make sure to name them 
correctly. 

 

Choose the Interview 
Clips 

 Choose the interview clips that you’ll have in your podcast using the index.   

Gather the Interview 
Clips 

 Find the interview clips that you’ll put in your podcast using the index. Export the 
clips into new mp3s. 

 

Combine Sound 
Clips 

 Import and join together all of the sound clips you have for the podcast. Make 
sure you check the story map for their order. 

 

Find Music  Find relevant music that you can use for the podcast.  

Find and Record 
Ambient Noise 

 Find sounds/noise that fits into your podcast and record it. Then, upload those 
clips. 

 

Blend Music and 
Voice Recordings 

 Make the music that you chose work with the voice recordings that you’ve 
imported into the podcast. 
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